Support issue

Inside:
Matt Allwright
The BBC’s Rogue Traders frontman gives us his sideways view on customer support

Keeping up to speed with changing legislation
An in-depth look at HMRC’s new online filing system

Make support your number one priority
Mary Mackle of Mary Mackle & Co. Accountants tells us what support means to her business
Editor’s note

Happy New Year

Every new year brings new challenges and opportunities. And as 2010 begins, we all have a great deal to plan for. With several important legislative changes about to take effect – a return to the standard VAT rate and greater moves towards XBRL online accounts filing – as well preparations for Payroll Year End, it is a busy time for the industry. We hope to help you embrace all of these new opportunities and offer even more value-added business services to your clients as we move forward together.

‘Support’ is central to everything we do at Sage and the theme for this edition of exchange. Whether it’s helping practices prepare for PYE in our page 20 article, or outlining how XBRL will work for you – pages 8 and 9 – this issue is packed with practical advice, technical updates and useful features to help us all in 2010.

As Sage’s new Managing Director, Jayne Archbold, makes clear in her article on pages 4 and 5, providing fantastic customer service is what makes us unique. And our round table and Club membership features – taking in opinions from Sage professionals and accountants working across different-sized practices – provide useful snapshots of how the support we provide filters down to not just you, but your clients too.

As a thank you for responding to the questionnaire in the launch edition of exchange, 5 customers have something extra to celebrate in the way of £50 Amazon vouchers. They are: Robert Clarkson, from Clarkson & Co., Bradford, Rachel Lynes, from Edwards Pearson & White, Warwick, David R Nicholson, from A D Associates, Lincoln, David Brash, of David Brash Consultancy, Auchterarder, and Shona Currie, from Brechin Tindal Oats, in Glasgow.

In this edition we also talk about the annual Pulse survey, which is our way of benchmarking the industry. We really want to understand the current and most important issues impacting on the accountancy profession and what needs to be done to address these, which will enable us to provide even better support. Plus, it gives a view from both sides of the fence and allows accountants to see what their clients really want and what issues affect them.

And finally, your feedback on the new format of the magazine and anything else we do is always appreciated so please do let us know what you think, by emailing us at exchange@sage.com

Here’s to another great year.

Steve Porter
A question of support...
by Matt Allwright

An icy disregard for one’s neighbours is a wholly laudable and praiseworthy aspect of the British psyche, and don’t let anyone tell you any different. It comes from us being what the Japanese call ‘Shimaguni’ – island country culture, roughly translated – and it’s one of the many things along with a love of fish and slapstick humour, that the land of the currant bun shares with the land of the rising sun. Like the Japanese we sit in the middle of a freezing cold sea next to a giant landmass, repelling invaders and relying on no one but ourselves to sort things out.

Oh it’s all very well having cosy European land-locked neighbours, who can pop round and borrow the odd cup of sugar (money, oil, manpower), until it all turns nasty, and then guess what? Someone takes a pot shot at an Arch Duke and all hell breaks loose. Before you know it, national boundaries are oscillating back and forth like the strings on a double bass.

Ice-cool Britannia doesn’t like receiving support from anyone. It’s a sign of weakness, and it’s reflected in our primary language. Income support, surgical support, athletic support: all of these are wholly negative terms, indicating that somewhere along the line the recipient has come a cropper. Customer support is another one. Just try this one on a loved one: ask them to lie down and close their eyes, and word-associate with whatever you whisper in their ear. Then, when they’re nice and relaxed, say

“customer support.”

In my scientifically dubious experience, I have found

• 25 per cent of respondents start crying uncontrollably
• 15 per cent of respondents assume totally unconvincing Welsh accents
• 34 per cent of respondents start obsessively punching the number ‘0’ on their mobile phones
• 12 per cent of respondents start punching anyone they can find
• 8 per cent of respondents start humming Greensleeves
• A further 18 per cent of respondents lose the ability to add up

My personal favourite misnomer is the chic for Internet Service Provider customer support help line charging. I recently left my ISP. For obvious reasons I won’t name the company, but it’s a big’un. When I first joined them, sometime in the last millennium, they used to have a really straightforward idea: “As you loyally give us money every month for the big tube of cyber-fun we’ve stuck in the back of your computer, then if something goes wrong with that tube, call us for nothing and we’ll use a big brush to clean it out.” I liked the simple peace of mind this supplied, and, being Shimaguni British, used the helpline like I used my NHS doctor, only calling up if things were really quite desperate and/or falling off.

Then all that changed. Suddenly one day when I rang up, I found that I was paying really quite a lot for my computer doctor to give me a cure. It was something like £1.25 a minute to speak to someone AND their ability to sort it out seemed to have been halved AND, for some reason, their healthy cyber-patient was now decidedly wonky, and sitting in their waiting room most evenings, reading Country Life, to carry the analogy all the way through (things kept going wrong with my internet connection). The worst bit of it all was that it appeared that due to the length of my loyalty to my ISP, I had somehow been shunted into the sidings of said organisation, and had a specially daft team of nano-numpties allocated to looking after my specific and clearly quite outdated needs. Thanks for your money for the last decade or so. Welcome to your customer retirement home, have a cup of weak tea, Eggheads begins in five minutes.

Leaving an ISP is marginally less traumatic than leaving your spouse. Changing your email address feels like throwing your house and office keys into a canal and hoping you left both doors open so you can get back in. Nevertheless it was clear to me that as a good Shimaguni Brit I no longer had any other option. My ISP had made that classic error of confusing a Customer Support line for me with a Revenue Support line for themselves.

And that’s something I just can’t support.

Matt Allwright is a journalist and broadcaster born in Reading, Berkshire.

He worked for BBC newsrooms until he was discovered, when he became a reporter for BBC1’s Watchdog and Weekend Watchdog.

In 2001 he started writing and presenting Rogue Traders, a consumer investigations show which involved him dressing up as various characters and springing out on dodgy individuals.

Matt is also working with Anne Robinson on the new-look Watchdog and occasionally pops up on The One Show. When he’s not chasing rogues he reads crime fiction and wonders what it would be like to write it.
Fantastic customer service and support is something we all appreciate. And as we head into a New Year, providing the best business services we can will be vital to our continued success. Providing and receiving the right support – the focus of this edition of exchange – paying attention to detail and dedication to meeting clients’ needs is what makes us unique in the marketplace. Whether it’s creating dynamic training programmes for employees or providing accountants with the software they need from us, we are always there to listen and respond. It helps us make the most of our fantastic teams and filters down to customers and clients at every level.

Since joining Sage Accountants’ Division, I have already seen this service and the difference it makes firsthand – from colleagues helping me adjust to my new role, to time spent observing different departments in action – and I relish the opportunity to offer even more support across the company.

As Managing Director, I am particularly proud to be supporting our Accountants’ Division. As well as the personal development coaching and mentoring available to all staff, new trainees are given enhanced training to make sure they can continue to offer the very best service. In addition to technical support we are helping them to develop their communication skills, to ensure they understand what clients want.

Giving accountants a choice of how to contact us is crucial too. Accountants’ time is precious so we must make sure we are there for them when they need us – offering fast, effective help. In the customer service department our ‘X Factor’ initiative has given customer service staff a new goal too. We have scrapped call targets, preferring to concentrate on value-added customer contact instead, allocating practices a key contact so that our agents really get to know practices and how their systems work to give them the confident, reliable service they expect.

With that in mind, I am delighted to welcome Gary Young in his new role as Head of Customer Operations. Gary has a fantastic track record and has been passionate about delivering the best possible service to clients during the 13 years he has been at Sage. Now he is looking to draw on his talents and experience in the small and mid-market business fields to bring his extraordinary understanding of customer needs to bear across the whole Accountants division.

Our annual Pulse survey tells us just how much you need and value this support too and by conducting it we can really benchmark the industry. The end results provide us with a view from both sides of the fence which allows accountants to see what their clients really want and what issues affect them. This type of feedback is crucial, so we look forward to reading your opinions.

As our article on bouncebackability on pages 10 and 11 illustrates, there are now real signs the UK economy is starting to recover. Financial experts agree that 2010 will be a crucial year for business, one in which we hope to see genuine cause for optimism. It won’t be an easy process – and as always we must be cautious – but with the type of enhanced customer service and support we all cherish, underpinning everything that we, our accountants and their clients do, we can all enjoy moving forward into this bright new year.
Support. It’s a business necessity – and something we could always use more of. So for the latest in our series of round table debates, we asked a panel of experts and practitioners to examine the concept of support. The panel discussed what it means to them – their businesses – and the role Sage’s support plays in the services they offer.

What does the term ‘support’ mean to you?

RB: Being on the end of the phone whenever clients need us and using Sage and the knowledge base to find answers.

GG: It’s my raison d’être. Giving clients what they really want is what we’re all about.

KT: I agree. It’s the importance of getting it right first time and providing support that is appropriate.

PC: It’s about being proactive isn’t it, being there to offer better service again and again. I’ve become a virtual financial advisor to many of my clients – using Sage software means we can work together in real time.

GY: On a fundamental level it’s about offering help and assistance but it’s also about providing value-added service.

How essential is it to the way you work?

RB: It is a major part of our business. A lot of our clients are long-term ones – we’ve been with them since they started so our businesses have grown together and have been there to support them every step of the way.

GG: It covers everything – marketing tools and practice management tools.

KT: It’s vital. Customers should feel we are tailoring our support to their needs. On an internal level, the partnerships my department has with others – especially HR, IS and Commercial Development – help us develop greater understanding of products and clients.

PC: I couldn’t agree more. Offering the level of service I do is what I really enjoy about my role. The support that I receive from Sage helps me to do that.

GY: It’s imperative. Providing great support is what will guarantee long-term, joint success and that’s something we’re all aiming for.

Can you talk us through your clients’ core service needs – and any specific steps you have taken to meet them?

RB: Our clients are looking for support in lots of different areas of their businesses such as tax and strategic planning. We act as an extension of our clients’ management teams.

GG: They are extremely wide and varied. Yesterday I was in the North helping with some succession planning, today I’m working on a professional development programme; it’s about providing appropriate service.

KT: The two most common are: ‘How do I do something?’ or ‘I’ve got a problem with’. Providing answers is a challenge we meet every day.

PC: My clients are coming to me for guidance and general business support. Management accounts, cash-flow forecasts, tax and business planning are some of the most common things I help with.

GY: Our clients want a range of services and they want us there when they need us, and more general business advice too.
How have these changed in recent years? Has the economic downturn affected the level and type of support expected by clients? How has it affected the service accountants offer?

RB: Out of 300 plus clients, we’ve only seen a few go into administration. Many have actually been buying and selling businesses and we’ve been helping with that.

GG: Marketing has definitely reared its ugly head again! There was a time when the last thing accountants wanted was another client, now they’re looking for help with lead generation and new services.

KT: We have seen that some of our customers have had a lot of staff changes – because of early-retirement and redundancies – and that means more people contacting us because they might not be as familiar with products. They are using different products too to cope with things like cash-flow.

PC: Everyone is being squeezed and the banks aren’t there to help anymore so cash-flow especially is more important than ever – without that businesses can’t survive.

GY: Fifteen years ago it was about providing a helpline, now it’s about value-added service. We’re much more pro-active – so for example, we’ll remind people about the VAT change before it happens.

What part does training and investment play in providing that level of service?

RB: We make sure new and experienced staff work together and we use Sage training too.

GG: You’re never too old to live and learn and I’m also a big believer in feedback and focus groups. Once a year I’ll take part in a wacky course to give me new insights.

KT: I think we’re all agreed it is hugely important. We are very specific about attracting and training new staff. It is an investment that pays off – my attendance rate is extremely high and we retain staff well.

PC: I train on new software to keep ahead of the new, updated products and I filter that down to clients. I think it’s important to invest in the right kind of software but then to make the most of it, to see real value from it.

GY: We invest heavily in training but we have to, to maintain the level of service we offer. It’s a long-term commitment.

What more do businesses need to do to enhance their support offerings?

RB: Keep focused on new opportunities by listening to what clients say they need.

GG: Think about marketing and always agree a fee before you start work, that way clients are aware of the value of your services.

KT: Keep diversifying into new areas – as they have with cash flow – and listen even more to what customers need.

PC: Be more customer-focused. A business is only as good as its customers.

GY: Think long-term; get insight into customers’ businesses and the challenges that they will be presented with.

How much is service a differentiating factor for your practice?

RB: It’s what makes us stand out as a business. Our packages include telephone support which means clients are not afraid to pick up the phone and run things by us.

GG: A great deal. We have always been at the innovative end of marketing so our success has been built on offering clients what they want before they know they want it!

KT: I agree with everyone else here – it’s the level and quality of support that makes a business stand out.

PC: I enjoy giving good support, which is why I prefer working with premium clients – people who want more than just the cheapest option. Offering enhanced, good quality support is what will keep customers coming back.

GY: It’s huge for Sage, our success is based on it.

How do business software providers help to deliver support? What steps can they take to provide better service in future?

RB: Using Sage makes everything faster for us – which in turn frees up more time to spend more of it getting to know clients.

GG: Everybody wants to free up more time for client contact. Embracing technology is a major force for doing that.

KT: We’re giving people the technical support they need at a crucial time for business – but we’re also helping them with issues that arise from that, and that is an enhanced service.

PC: They’re the backbone of my operation really. The only thing that would work better is offering more customer support – some kind of 24/7 service.

GY: Our products and support services give businesses the freedom to concentrate on what they’re really good at. They can let us take care of the technical side and let them grow their business. For us, the future is about taking that further – identifying new areas we can take responsibility for.
Keeping up to speed with changing legislation.

On 23 November 2009 HMRC updated their online filing system for company tax returns, a system that also supports the submission of XBRL tax computations and accounts – mandatory from 1 April 2011 onwards.

Corporation tax software
We worked closely with HMRC to ensure our updated corporation tax software would deliver an uninterrupted service either side of the changeover. As a result, Sage Corporation Tax (powered by Abacus) supports both the current and new HMRC software systems and will select the appropriate system to file. This is the first step on the journey to HMRC’s 1 April 2011 compulsory changeover to XBRL, with the focus going forward switching to accounts production software.

We’ll make sure that you are fully aware of the next round of changes and provide full visibility of our timetable for releasing accounts production software ahead of those changes. Here at Sage, upgrading and developing software to ensure you are able to comply with legislation and HMRC systems is the top priority.

The next major leap forward, then, is the requirement to file accounts to HMRC using a new specified format called XBRL (an XML-based format for financial reporting).

XBRL
Simon Taylor is a Senior Product Development Manager in the R&D department in the Accountants’ Division. Based at Salford Quays, he has been with Sage for 2 and a half years. He has spent 12 years working across the IT industry – training as a software engineer before taking up roles in project and programme management. He is an expert on the new XBRL and iXBRL systems and has been leading the Sage development team preparing for their implementation. Here he explains more about the changes taking place and outlines what they will mean for the accounting profession and software providers.

“For years there has been a growing awareness in the accountancy market of the potential benefits of a uniform digital reporting standard – and the UK profession is about to become part of the process making this happen. Following recommendations made in the 2006 Carter Report – a systematic review of HMRC’s online services – UK accounting will embrace a new mandatory filing regime after 31 March 2011. It will use new XBRL and iXBRL systems and will present huge changes, challenges and, in turn, opportunities for you and your practice.

One of Carter’s primary recommendations was that the government should set an aspirational goal of submitting all business tax returns online by 2012. In line with this target it will be mandatory to file all corporation tax returns – the CT600 return form, tax computations and accompanying accounts – electronically, using XBRL. This will apply to all company tax returns (with a few exceptions for certain clubs and charities) for periods ending after 31 March 2010 and filed after 31 March 2011.

Paper submissions generated using applications like Microsoft® Word or Excel and electronic submissions incorporating accounts in PDF format will no longer be accepted. As software providers, we are updating our systems to prepare for this. Our accountant customers, and your clients, need to make sure they are equipped to make this change as seamless as possible.

‘But what exactly is the new system?’
In simple terms, XBRL is a web-based computer language, written specifically for business reporting. It is primarily used to tag pieces of data so that users can compare and contrast one entity to another, regardless of physical location or industry.

In the past, if you wanted to compare the accounts of Spar and Tesco, for example, you would have to spend a long time ploughing through them to find the right details to analyse. You would then need to key the information in to a spreadsheet and manually compare the figures. But when we start using XBRL, all accounts will be ‘written’ in this same language so you can instantly identify and compare like with like more easily – for example, looking at a variable like turnover.

iXBRL is a translation of this system – transforming something a machine can read into something a person will find easy to look at. It is a HTML-based file and retains the author’s own style and layout, making it accessible via a web browser.

Key Drivers
The two main drivers behind the adoption are quality and efficiency. Both of which will increase the quality of the information presented to stakeholders, so enabling them to make better decisions. It is the aspiration of government and law makers that XBRL becomes the standard globally and information can then flow more easily and quickly. We are not the first to adopt this technology: America, Holland and Denmark to name but a few have already adopted XBRL.

The change is especially significant in the current economic climate. Its uniformity will make it easier for agencies like HMRC to look at data and make judgements in tax related areas. It will also prevent Companies House from having to re-key the information it receives on an annual basis from companies. The impact on practices, and their clients, will be significant too. The mandating of XBRL by HMRC and the acceptance of iXBRL files by Companies House is a major move forward and at Sage we have dedicated a great deal of time to making sure we’re doing everything we can to help clients get it right.

Compliance
How practices comply and how much work they need to do to get there will depend very much on how they file their accounts now. For the 75 per cent of accountants who already use software packages to generate their accounts, it may just be a simple case of updating to the latest version.

We are building XBRL compliance into our accounts production packages as well as our corporation tax software, and have developed new products for release in July 2010. Training, installation and even conversion programmes to translate data from other software, are all available to help ease the transition. For the 25 per cent of accountants who still work manually, it is undoubtedly going to be a bigger leap forward. But at Sage we intend to make this leap as painless as possible.”
Online VAT returns made simple

Suzanne Wardingham has been working with Sage as a VAT specialist for the past 4 years, after more than a decade spent working in private practice. Here, she talks us through the forthcoming changes – and explains what they will mean to you and your clients.

What are the main changes?
Filing VAT returns online is going to become mandatory for two groups of businesses. Any clients that become VAT registered on or after 1 April 2010, as well as any that have an annual pre-VAT turnover of £100,000 or more, will have to comply. At the moment any business can file VAT returns online if they wish to but it is not a legal requirement.

What deadline are we working to?
The change will be effective from 1 April 2010 and initially will only apply to the two groups above. In the long-term, HMRC will be looking to roll out the process to cover anyone VAT registered.

How will this affect practices and their clients?
On a practical level, it will give clients more time to complete their returns. Instead of allowing extra days for postage and processing, accountants will be able to work online, up until the final completion deadline. There should be fewer worries about postal strikes or items being lost in transit too. In addition, when submitting online you must pay by electronic methods; this will extend the payment date to HMRC, which will provide a cash-flow benefit to businesses. All practices will have to do some initial work to make sure they and all their clients are registered with HMRC. Clients will receive a unique activation pin code to pass to their accountants allowing them to act on their behalf.

How will Sage be supporting its customers through this transition?
We have had online filing in our software for the last three years – so practices and clients should now be familiar with the way it works. We are confident that the products are working well – clients will calculate their VAT return in the normal way and then submit the return in a few small steps – and we will have technical and telephone support to deal with any queries or problems.

Telephone support: 0845 111 1111
After the worst year in its history, the UK’s manufacturing industry is finally showing signs of continuous growth – signalling fresh hopes for real long-term economic recovery in 2010.

Last month the manufacturers’ organisation, EEF, reported that conditions in the last quarter of 2009 had continued to show signs of improvement, helped by general world recovery and a weak pound.

In a marked change since the summer, the proportion of companies seeing output and orders decline moved from a negative to an almost zero balance, while export orders improved from minus 44 per cent to minus 5 per cent since the summer.

Most UK regions have seen output rise too. From lows reported over the past six months, a balance of South East and South West companies reported output returning to growth over the past quarter while the upturn in motor vehicle production helped the West Midlands’ output edge nearer to zero.

These small steps forward are being welcomed as the first on a long, careful road back to financial well-being. The experts say that building on them could be key to the country’s bouncebackability and developing a long-term strategy for escaping recession.

The importance of manufacturing cannot be underestimated. Responsible for 55 per cent of UK exports, its productivity regularly outpaces economic growth.

As Jeegar Kakkad, chief economist at the EEF, explains: “Manufacturing has to play a role in solving the economic imbalances we face – whether financial, demographic, security or environmental.”

This is certainly the case globally. Super producers like China – hit hard by recession – saw output climbing at the fastest rate in five years in November. And in Europe, there are encouraging signs too, with Germany regaining its position as the world’s leading manufacturing exporter.

Here in the UK, despite recent high-profile closures like that seen at steel-makers Corus, experts say manufacturing growth could be a way of rescuing our entire economic structure – and creating a more secure environment to cope with any future ‘meltdowns’.

With fears of a ‘double-dip recession’ still looming, analysts are keen to ensure the mistakes that led to the near collapse of the banking system aren’t repeated and that any progress made is real and long-lasting.

The precarious nature of the wealth generated by the very systems that caused the crisis – risk-chasing banking houses and a seemingly ever-growing housing bubble – is now recognised as being unsustainable and dangerous.

Growth in manufacturing industries on the other hand is viewed as a much safer long-term proposition and one that could help ‘re-balance’ our beleaguered economy.

Adair Turner, Head of the Financial Services Authority (FSA), has argued repeatedly that we need to find an effective replacement for the previous strategy of debt-fuelled and public sector-oriented growth. By creating jobs and exports, manufacturing provides a lasting solution.

Leading UK think tanks, including the Labour-supporting IPPR and the centrist Social Market Foundation, are working on policy ideas for how government can help the economy grow faster by creating a more vibrant manufacturing base.

But as business analysts have pointed out, outside certain specific high-tech sectors such as aerospace, defence and bio-technology the UK’s manufacturing output is very much an industrial one. Stuck in a ‘low value, low skills’ trap, they argue this makes it extremely vulnerable to undercutting by foreign competition.

It is more likely that real future development will come from new industries where the UK performs well – emerging green technologies as well as media and cultural production.

Whether these can right the wrongs done by high public sector borrowing and over-dependence on the banks remains to be seen. Another leading EEF voice, Lee Hopley, remains hopeful – but urges caution over the speed of change.

As he says: “While conditions are continuing to improve on the back of recovering world markets and a weaker currency, there is little to suggest that we are in for anything other than a long, slow haul out of recovery.

“Manufacturers have been grappling with extremely difficult trading conditions for more than a year now, but we’re not out of the woods yet and a great deal of economic uncertainty remains.

“Cutbacks in investment remain of particular concern. While the need to address the public finances in the long term is urgent, this must be balanced with the need to continue with supportive measures underpinning a productive sector of the economy.”
At Sage we understand how precious time is – both to you and your clients. Our Accountants’ Club membership is designed to help you do what you do best, which is offering value-added service to your clients.

Guaranteeing high-level targeted support, becoming a member will ensure that using our software is always a straightforward, reliable experience giving your clients support and speedy results they can rely on. It means we can be experts in your practice and you can spend time building relationships and creating new opportunities.

Club Membership

Membership can save you and your clients time and money – and you will feel the benefits immediately. Helping with compliance is key and as a Club member you’ll automatically receive demonstration copies of our latest software – including Sage 50 Accounts, Sage 50 Payroll, Sage 50 HR and ACT! by Sage – before your clients. This means you can get to know any new products or features first, speeding up responses to client queries and minimising the impact of changing over to the new packages.

David Hall

For us as a business, the level of technical support and contact we get with ACPL is what defines it as a vital service. It makes it extremely easy to keep in touch with our account manager and to offer the best sales options to our clients. We regularly sell Sage to our existing clients – to help them meet legislative requirements such as filing VAT returns and annual accounts – but also to aid with broader financial management; looking at debt management, strategic planning and business development. As an organisation that prides itself on being ‘hands-on’, we like to think that the enhanced support we get from our membership filters down to clients.

Managing Partner at RHK, Chartered Accountants, Gateshead

Our award-winning technical support is another reason for signing up. Straightforward, easy-to-follow advice for demonstration software is only ever a phone call away – enabling you to offer a consistent, reliable service to clients. Exclusive software savings are available too and can be passed on to your clients.

In addition to this myclubdownloads.co.uk is open to all Club members and provides product brochures as well as access to Sage branding and logos for your use.

A higher level of support is available for those who want to upgrade to Sage Accountants’ Club Payroll Bureau. This allows you to run payroll as part of a range of value-added services for your clients.

You can take over responsibility for a range of tasks, including deducting tax and national insurance, processing statutory sick pay, maternity pay, tax credits, wage arrestments, student loan contributions and pension payments, as well as managing compliance with legislation software updates.
If offered via Sage 50 Payroll Professional software, members can also process large volumes of data for clients with unlimited users. The membership includes priority access to the Payroll Support Team – ensuring that deadlines for Payroll Year End and salary payment dates are always met. Members also have the option of offering clients an HR Advice Service too, for just £135 + VAT.

Providing such an invaluable service may help members win important new business, such as final accounts preparation.

**SageAccountants’ Club Priority Link (ACPL)** is our premium level membership. Offering dedicated, prioritised service, members are provided first-class backup.

As well as all the benefits of our other Club tiers, it includes a priority telephone support service and exclusive upgrades. Launched this month, members will now be able to use our ‘automated response’ phone line to deal with queries, which is triggered in the unlikely event that your call isn’t answered within 6 rings. You simply dial up, enter your details and wait for an automatic call-back, saving even more precious working time.

Members are given prioritised, specified software upgrades too – with new updates being despatched before they’re made available to anyone else. There’s also access to Sage 50 Accounts 2010 Client Manager, our multi-company accounts software developed specifically for accountants in practice.

This sophisticated software enables you to share accounts data with your clients using the Accountant Link tool, allowing you to work alongside them in real time – so you can say goodbye to ‘Backup and Restore’.

**SageCover**

SageCover and SageCover Extra are 2 options for any clients wanting comprehensive support and the best discounts on software and services. Offering complete packages of dedicated online and telephone support, it is a great way of making sure that our software always works as efficiently as possible.

As well as technical shortcuts, jargon-busters and access to the ‘Ask Sage’ database, members receive regular discounts on software, a free e-newsletter and Sage HR Advice Standard, which offers access to an online HR Advice service. This service provides access to news, documents and guides to ensure compliance with HR Management issues and changes in employment law.

**Helen Cohen**

We subscribe to ACPL and Client Manager Priority Support – and they’re invaluable to us.

That’s why we always recommend Sage – especially for bookkeeping. It works as a service to our clients rather than just a sales add-on.

Clients know they can depend on us for best advice. It’s all about developing worthwhile mutual business relationships.

For us personally, having a dedicated telephone helpline and a proactive account manager are life-savers because they save us and our clients so much time and money.

**Practice Manager at London-based accountants, Grunberg and Co.**

**Alan Taylor**

After 15 years in practice, I’ve found Sage’s Club Membership to be the best form of support on the market. It has lots of advantages but one of the most important for us is having a personal account manager.

Dealing with a single point of contact is really helpful when it comes to obtaining quotes, placing orders and problem solving, which allows us to have better relationships with our clients. For example, if I’m with clients and they want a price on something, a quick phone call is all it takes and we can pass on any discounts we benefit from too.

**Practice Manager with Scott and Wilkinson, in Lancaster.**
Continuing support to help you grow
In our last exchange we updated you on GrowGreenShoots.co.uk, our website established to help you offer your clients the very best value-added service. In this edition we outline the most recent additions to the site – including some updates solely for your practice.

The New Year brings some important additions to the site offering you even more access to key areas of information and product knowledge for Sage software. Our updated brochures Guide to Sage 50 HR and Guide to Sage 50 Payroll are among those available to download or view online, along with our comprehensive support to you help deal with topical concerns like this Spring’s VAT rate change.

With more businesses than ever turning to their accountants for advice and support in 2010, there is real scope for us all to expand the services we offer. Helping to create mutually supportive partnerships has always been at the heart of what we do and it’s something that we’ll continue to expand on with www.growgreenshoots.co.uk.

The website is part of Sage’s ongoing commitment to help you offer your clients even more value-added services – providing all the support and information you need to help you recommend the perfect software solutions.

Here, we explain exactly how the site could help you as we outline areas of development in our new Sage ‘People’ Products, which includes help for new online filing rulings.

Looking after your clients has never been so important. In the current climate, competition for business is more fierce than ever, increasing the need to expand into new markets and retain loyal customers. Whether it’s choosing software solutions or offering advice on upgrades, the site’s easy-to-navigate pages are a vital business tool. And as well as general product information and ‘What’s New?’ updates, a designated Accountants’ page will also assist with specialist enquiries.

‘What’s New’
The site is constantly being updated and contains content for the latest 2010 versions of our software. As well as brochures for our Guide to Sage 50 HR and Guide to Sage 50 Payroll packages, you can also view recent communications sent by our Small Business Division to your clients.

2010 brings some major accounting changes too; for example, the new VAT rate reverting back to 17.5 per cent after last year’s reduction. Grow Green Shoots can help you navigate the change and make sure your clients are all up-to-date. Simply take a look at the information we’ve posted, along with the new online demonstration tutorial for Sage 50 Accounts 2010 users that provides step-by-step guidance.

Contact: Our website www.growgreenshoots.co.uk and customer support line 0845 111 1111 are here to help you.
Ringing the changes
Make offering great support your New Year’s resolution

Gordon knows as well as anyone how vital the issue of support is to the success of any practice. Here, as we welcome in the New Year, one which economists hope will signal the start of our move out of recession, he outlines the type of services businesses need in these difficult times. He talks to Sage about how he provides great support and tells us what people can do to help themselves.

No one denies that we’ve seen tough times recently, and small businesses often bear the brunt of a recession. But as someone who has worked through the last economic downturn, and survived, I know there are steps we can all take to help us make it through.

Marketing yourself and your business has never been more important. Making people aware of exactly what services you offer, and trying to give clients more by offering what they want before they’re even aware that they need it, is the key to doing well. But how do you know what they want? It’s only by really engaging with clients and getting to know their practices that you’ll find out what new support you can offer.

As accountants, 70 to 80 per cent of our business will always come from traditional areas like tax returns and end of year accounts. The other 20 to 30 per cent is up for grabs and we have to be proactive about securing it. Diversifying into areas like tax strategies and wealth management can be very lucrative. For many small businesses, 2008 profits might have been high but 2009 profits are likely to be low, so managers are looking to accountants to find ways of reducing their tax bills. You can embrace this as a new business opportunity.

Attracting new clients is another vital step. Many will be happy with their existing accountant taking care of their compliance but might welcome the idea of you, as a newcomer, looking after other areas of business for them. The role of the accountant has changed so much. In the past, people had their own accountant just as they had a lawyer. Now, people are looking to segment the support they receive — turning to several specialist accountants to meet different core needs.

Data mining can be very productive and a great way of targeting new business. I always advise clients to use their own databases to search for new opportunities. By segmenting your database — for example to identify customers of a certain age — you can tailor services to their potential needs. So if you have a group of people approaching retirement age, why not approach them about help with succession planning or retirement packages?

As I have outlined, there is a wealth of opportunity for proactive accountants to win new business. By the same token, this means that all practices are at risk of losing customers too — either to competitors or people looking to cut costs in these tough times. Retaining clients and winning their loyalty should be a fundamental concern. If you don’t take care of your clients you deserve to lose them.

At 2020 we practice a ‘before, during and after’ code to systemise contact with customers and make sure they are always at the centre of our work. It sounds simple, but forward and strategic planning are two of the best tools for keeping ahead of the competition. Even the smallest practitioner can be a fantastic planner and maximise the opportunities he or she has. Small doesn’t mean paying less attention to detail. In many ways, having less clients can mean the chance to develop a more in-depth relationship with them all.

It is a business basic which so many people forget, but taking a close look at your costs can save you a lot and mean the difference between going under and surviving.

During the last recession I didn’t hesitate to cut staff — knowing that if we came out of it I could re-hire — and it helped me make it when others didn’t. Staffing levels have to be monitored. If you are going to make cuts, then cut deep and don’t wait to act. There is nothing worse for morale then staff working with the threat of redundancy hovering over them. It is counter-productive and wastes everyone’s time.

Cash and cash-flow have never been as important. Without the backing of banks and with few sources of lending available, no business can survive without real money in its accounts. Don’t be afraid to ask clients for help or to pay quickly. We have a pie-chart sticker we use on invoices with three areas saying, ‘Please pay up... so that we can pay someone else...so that they can pay you’. If customers value your support, they will respond.

Listening to clients and their customers will help you understand more about their individual business needs and help you review your own performance effectively. Surveys, focus groups and old-fashioned networking, taking clients out and calling them to check in, will all bring positive results.

Technology is a fantastic way of reducing the amount of manual labour your practice is faced with, freeing you up to spend more time engaging with and generating business from clients. I make sure my Sage software and my training on their products is fully up-to-date so that I can maximise its use and make it work well for me.

Gordon Gilchrist
**CASE STUDY**

**Make Support Your Number One Priority**  
Mary Mackle

The standard of support Sage provides is one of the things that makes us unique – and the reason so many accountants are happy to recommend our products. Mary Mackle, one of our elite Accountant Partners, finds Sage Accountants’ Club Priority Link (ACPL) an invaluable support to her practice.

Drawing on her vast product and training knowledge, her company, Thyme Training, which is an integral part of Mary Mackle & Co, sells and offers help and advice on all aspects of Sage software ranges. From the most basic support to top flight Priority Link membership such as Mary’s, tiered appropriate service is an essential. Now businesses are spreading the word about our products. Here, Mary explains what Sage support means to her business and how it is helping others develop theirs.

As a valued customer for the past 15 years, we have come to rely not just on Sage’s software but also on the support network that helps us use it so effectively. A lot of our clients look to us for help with vital services like payroll and accounting Year End – where we’re working to a strict deadline – so being reliable and dealing with problems quickly is essential. That is why having access to ACPL as part of the Accountant Partner Programme has proven so invaluable for us.

Any accountant can join ACPL but you have to be an Accountant Partner to access the highest tier. Joining the Accountant Partner Programme automatically gave us access to ACPL, and provides us with a whole host of additional privileges in return. We have been in the Accountants’ Club for 10 years but we’ve only been an Accountant Partner for the last 3. It has made such a difference to the way we work that when a new Accountant Partner Programme was launched in the last few months we were one of the first to sign up.

One of the most important benefits that ACPL has brought is the fast phone response. Calls are guaranteed to be answered within 6 rings and, where possible, dealt with there and then. The staff are very, very well-versed in the product. Their knowledge is second to none. On the rare occasions someone hasn’t been able to give us an immediate answer, they’ve called us back so we don’t have to hang on the phone.

We have now virtually eliminated downtime by spending less time waiting on the phone and taking advantage of the much welcomed call back service. The ACPL service means you can continue to work while you’re waiting for an answer. In the past we have used other providers but the service wasn’t always there when we needed it. We’d be on the phone at busy times and not able to get through. That just wasn’t good enough.

We process payroll for a number of clients, as well as offering support to others who process their own payroll. It’s such an important service, making sure people are paid, that you need to know you are supported. We all need speedy, reliable service – it helps us process our workload faster which in turn makes our clients’ jobs easier.

The customer contact we receive through the Accountant Partner Programme is another positive aspect. We have our own internal and field account managers and we enjoy daily contact with them. If we need help or a quote on anything, he is the one we speak to. We know the whole team and more importantly we feel that they know us and our business needs. Their support means we can rely on them which in turn means clients know they can depend on us because any problems we encounter will be dealt with quickly by Sage. It’s a sense of responsibility that filters down. Our area manager has visited our practice to demonstrate new products, run joint seminars and to see how we work. We also get added value via the webinars which are a feature of a new Accountant Partner Programme.

A lot of people aren’t getting the most out of their Sage products, particularly at the accountancy end. They buy in software to deal with a specific issue but don’t always look beyond that, to see what more Sage could help them achieve. So we have started to develop a new business, Thyme Training, which looks at offering sales advice, help and support on software. At the moment we’re concentrating on Sage 50 Accounts and Payroll but we are looking to expand this year and hope to be accredited for ACT! by Sage in the near future. We can offer whatever level of support people need. From classroom courses to telephone help packages.

Sage is always ahead with the software, always very proactive and forward-thinking but without the support even the best software can’t be used properly. Their strategic planning means we can forewarn our clients of things that are coming up, for example the VAT rate change and make things easier for them too. We’re like a GP practice – our customers want us to know a little about everything. At the more specialist end of the scale we turn to Sage consultants for advice as they are experts in the field.

At the end of the day, being an Accountant Partner and having access to ACPL means that we know we can count on Sage for everything we need. No one can be an expert in everything but they really do seem to be and we’re able to draw on that knowledge and understanding, and pass on the benefits to our clients.
Mary Mackle & Co is celebrating 20 years in practice this year. An integral part of their business is Thyme Training which has been established specifically for clients who want to understand more about what Sage has to offer. The Thyme Training team has undertaken extensive training and examinations to become a Sage Accredited Accountant Partner and they pride themselves on the personal service they provide to their clients. Indeed, investment in the team has been substantial – including new facilities. As well as training, Mary and the team offer a competitively priced range of services including accounts preparation, audit, tax, company secretarial and training.

Thyme Training use Sage software in their practice to help them provide efficient and cost-effective services to clients large and small – they currently have a varied portfolio of clients using Sage and have worked closely with them in training, implementing and maintaining Sage accounts and payroll programs for the past 15 years. Their in-depth knowledge of the Sage 50 Accounts and Sage Payroll packages, together with their expertise and experience as professional accountants and tax advisors, enables them to provide effective solutions, saving time and ensuring compliance with legislation.
It’s all in the preparation – perfect planning for PYE

It’s one of the busiest times in the business calendar. Now that Payroll Year End accounts have to be submitted online, there is even more reason to plan ahead and with Sage’s help it doesn’t have to be hard work.

Updating software, selecting suitable support packages and registering early with HMRC, will make things easier and ensure you deliver the fast, reliable service your clients expect.

So what should you be doing, and when? Our step-by-step guide and timeline tells you everything you need to know about making Online submissions – and offers some essential practical advice for being prepared.

Register with HM Revenue & Customs (HMRC)

Did you know that it’s now compulsory for most employers to submit their year end returns online? There are, however, a few employers who are exempt – for further information visit www.hmrc.gov.uk/payeonline

Register with HM Revenue & Customs (HMRC)

Before an employer can submit online, they must register with HMRC for their PAYE Online for Employers service. As there are over 350,000 employers who have not yet submitted online, but must this year, please encourage your clients to register as soon as possible. To register, visit www.hmrc.gov.uk and click ‘PAYE for employers’ from the left-hand menu.

If your clients have previously submitted online, they don’t need to re-register.

Submitting on behalf of your clients?
If so, you’ll need to make sure that you’re registered as an agent with HMRC. For more information about setting up PAYE Online for Agents, please visit www.hmrc.gov.uk/agents/started-paye.htm

Check e-Submission settings
During registration you’re provided with a user ID and asked to choose a password. To submit returns directly from within Sage software, you must enter these details:

In Sage 50 Payroll, open e-Submissions > e-Submission Settings.

In Sage Instant Payroll, click Tools > e-Submission Settings.

If you or your clients have previously submitted online, we recommend that you check the details in your software’s e-Submission Settings. You can check the correct details by logging on to www.gateway.gov.uk and clicking ‘Manage Services’. Check your tax district/employer reference, login details and that the PAYE for Employers service is still active.

Submit on behalf of your clients?
If so, ensure that the ‘Submit as an agent’ check box is selected within your software’s e-Submission Settings and enter your contact details.

Check your software is up to date
Before making a submission, you and your clients should check that you’re using the latest Online submission files.

To do this within Sage 50 Payroll, open Help > e-Submission Version Check. If you’re not using the latest version, follow the on-screen instructions.

In Sage Instant Payroll, when you make a submission, if you’re not using the latest files a message appears advising you to install an update. Follow the on-screen instructions to install.

Need help from HMRC?
If you need any help from HMRC about registering or making an online submission, visit www.hmrc.gov.uk or call their Online Services Helpdesk on 0845 60 55 999.

If you need any further help from Sage, please call our Support team on 0845 111 1111
It's all in the preparation – perfect planning for PYE

Technology is always changing, and here at Sage we are committed to making sure that you and your clients can always access the most up-to-date software available. With this in mind, here some of our Sage product experts provide practical advice on how to stay ahead and make sure your software is working well for you.

Chris Strong Top Tip

Chris has been with Sage for 2 and a half years. His current role is Product Support Co-ordinator.

Having trouble keeping up with the latest software developments? Why not let the Sage Practice Solution Auto Update (SPSAU) do it for you? This simple-to-use feature is the easiest way to access all of our new developments – and make sure you’re using the very latest versions of our packages.

As well as regular reviews, SPSAU puts you in control by letting you choose when you want to implement the latest update.

Once an auto update is applied to the Sage Practice Solution server computer, the workstations or client PCs will automatically update. If you still need any further information, you can go to: www.sage.co.uk, and select the Support and Training tab to access our support website. Once logged in, proceed to the ‘Ask Sage’ section and search for article 24284, ‘Sage Practice Solution – Auto update service’, to get the extra help you need.

Darren Hall Top Tip

Darren has been with Sage for 18 months. His current role is Software Support Technician.

Making sure you see correct legislation on your final accounts is vital. So, if you want to see Companies Act 2006 legislation but only get 1985 Act information when running your accounts, you need to select the right commencement date for your clients within the accounts database. In order to do this, please follow the steps below:

1. Click Database at the top of the software screen
2. Click Accounts Options
3. You will be given a choice of three commencement dates:
   - The first is 1 October 2007 and refers to the 1985 Act
   - The second is 6 April 2008 and refers to 2006 legislation
   - The third is 1 October 2008 and also refers to 2006

Louise Shaw Top Tip

Louise has been with Sage for 2 and a half years. Her current role is Product Support Co-ordinator.

How to resolve error 1046 – Authentication Failure:

1. Ensure you can access the HMRC website at http://www.gateway.gov.uk/ using the user ID and password you entered in Sage Control Centre
2. Check you have accessed the HMRC website and activated your account
3. Make sure you are not using the same username and password for two different pieces of tax software
4. Check your tax reference and district number are correct and that they match the details HMRC have for you

To view or amend this please follow the steps below:

1. Access Sage Control Centre
2. Click File > Dataset Properties > Practice Details > View Practice Client > Tax Details tab > check or amend the following > OK

If you are still having problems, check the following:

• If your tax district or reference has changed during the tax year, ensure it matches the information HMRC have for you
• Make sure you have not entered your tax reference in lower case
• Ensure you have not entered your accounts office reference in the Tax district box
• If you are still having problems, contact HMRC Online Help Desk on 0845 60 55 999
Payroll Year End
Payroll Year End is a big task and it pays to be well prepared. We’ll provide more details nearer the time, but here’s some useful information to get you started.

Valid SageCover
To benefit from our support tools and information over Year End, your clients must have a valid SageCover contract. As part of this, we’ll send them a dedicated Year End guide and an updated CD, containing new legislation for processing in the new tax year. To make sure that your clients receive this vital information, get them to check their SageCover status and, if required, renew their contract as soon as possible.

Year End pack download
If you’d like to receive your Year End pack early, you can download it. Why not encourage your clients to download their pack too? If you choose to do this, you’ll receive it at least two weeks earlier than the postal pack. For more information and to register, visit: www.sage.co.uk/pyedownload

Perform a version check
It’s important to check that your clients are using compliant software for the 2009/2010 tax year. They should be using one of the following versions:

**Sage 50 Payroll:**
- 2010: v16.00
- 2009: v15.01, v15.02, v15.03
- 2008: v14.04, v14.05, v14.06

**Sage Payroll:**
- v12.10, v12.11, v12.12
- v11.13, v11.14, v11.15

**Sage Instant Payroll:**
- v11.10, v11.11

To check the version, open Help > About.
In Sage Instant Payroll, click Tools > My Instant Payroll.

Check contact details
Your clients should check the contact name, address and email address that we hold for them. They can check these details, and if necessary amend them, at: www.sage.co.uk/myaccount

Order stationery
Even though your clients must submit their P35 and P14s online, they must still provide employees with a paper copy of their P60. We recommend that they order this stationery, either from us or HMRC, as soon as they can. Remember that they may need a few extra to check print alignments.

Microsoft® Windows 7 and Sage Software
Windows 7 was released on 22 October 2009.

Prior to this we focused our efforts on testing all our supported versions of Sage software with this operating system.

To view the full list of Windows 7 compatible Sage software www.visit ask.sage.co.uk and read the following Sage articles:
- Ask Sage Article Number 24437 – Windows 7 and Sage software
- Ask Sage Article Number 24622 – Line100 / MMS / Sage200 Suite and Windows 7

If your Sage software version is not listed, or you have an earlier version, we recommend that do not use this software on Windows 7.

To check your current software version, open Help > About.
In Sage Instant Payroll, click Tools > My Instant Payroll.

If you have any queries or require further help, please call our Support team on 0845 111 1111
Backups for Sage Taxation

Even though complete disaster is rare, it is essential that you have a comprehensive backup routine in place.
The Sage Backup and Restore option ensures that taking and restoring a backup is a quick and straightforward process.
Note: This is the only way we recommend that you take a backup.

TIP

Backing up your ‘Sage Data’ folder is not the correct way. Since v9.0 no client data has been stored here. This folder holds utilities, configuration settings and your Control Centre custom letters only.

To take a backup of your data

Before using the Backup and Restore option, you must ensure that everyone logs out of Sage Taxation. Then follow these steps:

1. Open the Windows Start menu, choose All Programs, select Sage, then Sage Taxation.
   The Sage Taxation options will then appear.
2. Choose Sage Toolbox, then Backup and Restore.
   The Sage Taxation Backup and Restore window will appear and the following options are available:

   Backup – Restore – Settings – Erase

   Note: Erase should only be used when recommended by Sage Technical Support.

3. To check or amend the settings, click Settings then complete the Backup & Restore Settings window as follows and click OK:
   Click Settings to amend the settings for the backup location as follows if need be:

   Insert the location you want to backup to, at: Backups for the Sage Taxation will be stored in the following directory.

   Note: The backup location must be on the same drive as the SQL installation. For example, if SQL is installed on the \drive, the backup must also be taken to this drive.

   If you wish to create a new backup file each time, select Create a new backup file.
   Note: We recommend this option because if you overwrite the existing backup each time you take a backup, you will lose the historical data.

   However, if you do wish to overwrite the existing backup file each backup, then select the option, Overwrite the existing backup file.

   To backup the securities database each time you take a backup, select this check box beside Always backup / restore the Sage Securities Database even if not required.

   Tip: This is not essential.

4. To take a backup, click Backup. When prompted to check your databases, click Yes.
   Your databases will be checked and a progress bar will indicate the status of the check. A confirmation window will appear when the process is complete.
   Note: Before taking a backup, you must scan the data - so it can check the integrity of the data files.

5. To continue, click Yes then OK.
   The backup will complete and the Sage Taxation Backup & Restore window will close.

   Tip: For extra security, you can copy the backup file onto an external source, such as a CD drive or USB. You can use either Windows Explorer or My Computer to do this.

Product Release Calendar Update

<table>
<thead>
<tr>
<th>January 2010</th>
<th>March 2010</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sage Accounts Production Advanced (v10.01.01) CD</td>
<td>Sage Accounts Production Advanced (v10.02)</td>
</tr>
<tr>
<td>Sage Accounts Production (v6.2)</td>
<td>Sage Group Consolidation (v1.00)</td>
</tr>
<tr>
<td>Sage Company Secretarial (v5.2)</td>
<td>Sage Taxation (v13.00)</td>
</tr>
<tr>
<td>P11D (v2010)</td>
<td>Sage Instant Taxation (v13.00)</td>
</tr>
<tr>
<td></td>
<td>Sage Company Secretarial (v6.00)</td>
</tr>
<tr>
<td></td>
<td>Sage Instant Payroll (v12.00)</td>
</tr>
<tr>
<td></td>
<td>Sage Instant Accounts (v16.00)</td>
</tr>
</tbody>
</table>